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SA Vouchers — Registration Form Process
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How to set up a Registration Form

Please note: your registration form setup experience may vary depending on the configuration options

available to you.

Hover over Registrations and click Registration Forms.
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Click ‘Add New Form’.
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Follow the prompts to enter in all necessary information throughout the registration form. The ‘Settings’

tab gives you the ability to tailor your form to what suits you.

Settings

Form Name: New Registration Form

Type of Form:

Member registering to an Association
Member registering to a Club
Member registering to a Team
Member registering to an Event
Team registering to an Association

Form Enabled v

Payment is Compulsory [This option should be set only if payments are enabled and you have merchant account set up.]
Payments are enabled.
A Merchant account has been set up.
Bank Account has not been verified. Contact support if you feel this is incorrect.
When this option is set and there is at least one mandatory product, then registrants must also pay online in order to complete the registration. See

how to make a product mandatory.

Allow Member to Register ¢ Player

as: Coach
Official
Official
Misc

Volunteer

IMPORTANT NOTE: This will allow you to register and pay for multiple people at once. You need to check the boxes below to allow multiple adults

Allow multiple registration
or children [or both] to be entered using this process.

(family registration process):
Using this process, some details from the initial person’s registration will be copied to the subsequent forms, and a single payment will be made
covering all the registrations.

Allow multiple adults to register?
Allow multiple children to register?

o

Registration Options: Allow all registrations

=
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Each field that will appear on the Registration Form will be added under the ‘Fields’ tab. Scroll through to

find all necessary fields. Majority will currently be set to Hidden (meaning they are not shown on the
form), to add them to the form highlight the circle next to the field under either ‘Editable’ or
‘Compulsory’. Editable means users won’t have to fill out that field. ‘Compulsory’ means they will have
to fill out that field and won’t be able to continue through the form until the field has been completed.

SA Sports Voucher field requirements

Fields that need to be on the form to comply with the SA Sports Vouchers program —

* Legal first name:

* Family name:

* Date of Birth:

* Gender:

* Address Line 1:

¢ Suburb:

¢ State:

* Postal Code:

* Ethnicity:

* Phone (Home):

* Phone (Mobile):

* Email:

¢ Parent/Guardian 1 Firstname:

¢ Parent/Guardian 1 Surname:

¢ Parent/Guardian 1 Phone:

* Will you be providing your Medicare Number or your Australian Visa?

* Please provide your Medicare number (or Australian Visa if no Medicare number is held) below.

* Have you been a member of a sports club prior to the sports vouchers initiative?

* Do you consent to sharing information with the Office for Recreation and Sport?

* Have you claimed a Sports Voucher $50 subsidy with another provider for the same child?

* Have you already registered your child under the sports vouchers initiative this financial year at
another club?

* Do you identify as being an aboriginal or Torres Straight Islander?

* Do you come from a Culturally and Linguistically diverse background (CALD)?

FOXSPORTSPULSE.COM

Melbourne Level 9, 176 Wellington Pde, Sydney 4 Broadcast Way, TelAU 1300 139 970 Fax +61(0)3 8676 6971
East Melbourne VIC 3002 Artarmon NSW 2064 TelNZ (0800 808 202 ABN 12092 147 423 4



SA Vouchers Registration Form (#47853)

Settings Layout Products Messages Notifications

Choose the the visibility and editing options for each of the available Member fields.

Field Name Hidden Read Only Editable Compulsory Add Only [Compulsory)
National Number .

Member Number .

Active in Association .

Salutation .

Legal first name .
Middle name .

Family name .
Maiden name .

Country of Birth [Mother] .

Country of Birth [Father] 0
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Setting up custom fields

To add a new field that is not available on the generic form, click the cog on the right hand side of the

page. Click Settings.

Paistrations  Reports  Programs a-
ADVANCED SEARCH

Settings

ser Management

Audit Log

From the Configuration page, click ‘Custom Fields’.

Dashboard Members  Competitions Clubs Teams Communications  Registrations Reports  Programs -a

ADVANCED SEARCH

Configuration

These configuration options allow you to modify the data and behaviour of the system.

Manage Users and Security Configure Database Fields Change how information displays Setup Registrations Manage Competitions
* Password Management ¢ Custom Fields h * Member List Display ¢ Age Groups * Venues
* Permissions ¢ Field Configuration ¢ Seasons

¢ Manage Lookup Information ¢ Opt-Ins

* Member Packages

Dther

o Fitness Tests

* Sync Log
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When choosing a custom field, the following explanations of each type may assist you.

- Custom text fields - for the entry of text information

- Custom number fields - for the entry of number information

- Custom date fields - for the entry of date information

- Custom lookup fields - for the creation of drop-down lists from which an option can be selected

- Custom check boxes - for the creation of a single check box which can be selected (ticked) or left blank
- Custom member notes - for the entry of text information over several lines (only available for member
records)

Ensure that you click Update Custom Fields to save your new fields.

Manage Custom Fields

Member Custom Fields Club Custom Fields Team Custom Fields

Change the names of the custom fields below.

Update Custom Fields

Custom Text Field 1: Custom Text Field 1

Custom Text Field 2:
Custom Text Field 3:
Custom Text Field 4:
Custom Text Field 5:
Custom Text Field é:
Custom Text Field 7:
Custom Text Field 8:

Custom Text Field 9:

Custom Text Field 10:
Custom Text Field 11:
Custom Text Field 12:
Custom Text Field 13:
Custom Text Field 14:
Custom Text Field 15:
Custom Text Field 16:

Custom Text Field 17:

Custom Text Field 2
Custom Text Field 3
Custom Text Field 4
Custom Text Field 5
Custom Text Field 6
Custom Text Field 7
Custom Text Field 8
Custom Text Field 9
Custom Text Field 10
Custom Text Field 11
Custom Text Field 12
Custom Text Field 13
Custom Text Field 14
Custom Text Field 15
Custom Text Field 16
Custom Text Field 17
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When adding a Custom Look up, you will need to enter in each option manually. To do this, click Manage
and then Add New Option. You can Edit them by clicking Edit.

Tustom Date rield &

4 Custom Date Field 5

E Custom Date Field 6

i Custom Date|| Custom Lookup 1 %
8:

Custom Date

*  |custompate] Manage Lookup Information - Custom Lookup 1

Custom Date

T Choose a value from the list below to edit. Some options may be lecked by your nationalfinternational body
: Custom Date| gng cannot be edited.

Custom Date| Reorder the options by dragging them to position. The new order is saved automatically

Custom Date

s Custom Date| = — Yes Edit Delete

Custom Date 'ADD A NEW OPTION
Have you pla)

Custom Looki

Custom Looki

Custom Looki

Custom Looki

Custom Looki

Custom Looki

Custom Looki p—
Custom Looki

Custom Lookup 10 Manage
Custom Lookup 11 Manage

Custom Lookup 12 Manage

Form Layout and in- line instructions

The ‘Layout’ tab gives you the ability to reorder your fields. This is the order that will show on the
registration form.

The Layout page will automatically save when you click, drop and drag each field around.

Reorder the fields by dragging them to position. The new order is saved automatically.
Extra blocks of headers or text can be added by clicking the respective buttons.

ADD HEADER BLOCK [l ADD TEXT BLOCK

= Legal first name - Step 1

Family name - Step 1

Date of Birth - Step 1

Gender - Step 1

Ethnicity

Address Line 1

Suburb

State

Postal Code

Phone (Home)

Phone (Mobile)

Email

Parent/Guardian 1 Firstname

Parent/Guardian 1 Surname

Parent/Guardian 1 Phone
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= T-Block => Medicare Number or your Austra... " Eor | =3
= Medicare or Australian VISA? [ ruLes |
= T-Block=> MCN = =3
= Medicare/Australian Visa # [ ruies |
= T-Block => Member of a sportsclub? " Eo | =3
= Have you played elsewhere? [ ruLes |
= T-Block => Consent to sharing information... " Eor | =3
= Consent to sharing information [ Ruces |
= T-Block => Have you claimed before? "Eor | =3
= Have you claimed before? [ Ruces |
= T-Block => Registered previously? " Eo | =3
= Registered already this year? [ Ruces |
= RFTEXTIregoform|Do you identify as being an aboriginal or Torres Straight Islander? " Eor | [ REMOVE |
= Do you identify yourself as - [ Rutes |
= RFTEXTIregoform|Do you come from a Culturally and Linguistically diverse background (CALD)? "Eor | [ REMOVE |
= CALD background? [ ruLes |
= Country [ RuLes |

You can also add a Header (heading) and/or a Text (instructional text field) Block.

To add a Header Block:

Select the Add Header Block button

Enter in the Block Label - this is for you to identify the Header Block when arranging the layout
Enter in the Block Content - this is what will display on your Registration Form

Save Header Block

To add a Text Block:

Select the Add Text Block button in the Registration Forms > Layout Screen

Enter in the Block Label - this is for you to identify the Text Block when arranging the layout
Enter in the Block Content - this is what will display on your Registration Form

Save Text Block
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Registration Forms » Edit » Layout

SA Vouchers Registration Form (#47853)

Settings Fields Products Messages

Block Label:  Member of a sportsclu

Have you been a member of a sports club prior to the sports vouchers initiative?

Block Content:

Save Text Block

Notifications

Below is an example of how your form will look.

Legal first name: test

Family name: test

Date of Birth: 12/03/2011

Gender: Female

Ethnicity: Select Ethnicity -
Address Line 1: o

@ Choose Type @ Basic Info 3. Extra Info 4. Summary
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Reporting on voucher registrants

Running a report

To run a report on those members who have used the registration form click ‘Reports’ along the top
menu.

OX
[ FOX SPORTS PULSE Manager
Documentation Demo

Programs ¢'

ADVANCED SEARCH

Dashboard  Members  Competitions Clubs Teams Communications  Registrations

Documentation Demo

Once on the Reports page, click ‘Members’ in the left hand side menu.

Dashboard Members  Competitions Clubs Teams Communications  Registrations  Reports  Programs -a

ADVANCED SEARCH

Reports
Clubs
Reports are grouped into different areas depending on the data they report on. Choose the type of report you would like to use from the buttons on the left.
Competition
There are two types of reports present in the system.
Contacts . . — . ;
1. Quick Reports - Indicated by the ‘Run’ button, they are predefined and allow you & quick look at your data.
Finance 2. Advanced Reports - Indicated by the ‘Configure’ button, they allow you to define which fields you want to display and add custom filters to your report.
I Members I
Teams
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Click ‘Configure’ under Advanced Member.

Reports
Clubs
Members
Competition
Advanced Member Advanced Report Retention Report
Contacts
Set your own parameters etc for Set your own parameters etc for Set your own parameters etc for
Finance reporting on Members. reporting on reporting on Member Retention
Teams

Duplicates Summary Member Summary Member Demographic

Set your own parameters etc for Member Summary Report Member Demographic Report
reporting on how many duplicates there

are in each organisation. W Configure
Configure

National Accreditation Report

National Accreditation Report

iiore

Down the left hand side are the categories of database fields available to include in your report. Click on
one of these categories to expand the list to show all fields available within that category. Use the scroll
bar to navigate up and down the list of fields.

To select a field to include in your report, click on the field, and while holding down the mouse
button, drag and drop the field into the 'Selected Fields' area.

When you have finished setting all of the parameters for the report, click on Run Report. Your report
will be generated according to the output method selected.
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Different types of fields are available from different field groupings. Click the heading to open the group.

Click the 'Run Report’ button to execute the report.

» Personal Details
Selected Fields

~ Parent/Guardian
Lountry Ut sirtn (Fatner)

Parent/Guardian 1 Salutation First Name R x
Filter : v
Parent/Guardian 1 Firstname
Parent/Guardian 1 Surname
v/ Family Name R x
Parent/Guardian 1 Gender -
Filter : s
Parent/Guardian 1 Phone
Parent/Guardian 1 Phone 2 @ Year of Birth R
Parent/Guardian 1 Mobile Filter : +
Parent/Guardian 1 Email
Parent/Guardian 1 Email 2 ¢/ Gender - %
Filter : s

Parent/Guardian 1 Assistance

» Contact Details

» Interests Run Report

Identifications

Options
» Financial
Show ® Unique Records Only ©) Summary Data 0 All Records
» Medical Sort by National Number v Ascending %
Secondary sort by | None v Ascendin :
» Other Fields ’ ’ g
Group By No Grouping

Member Type - Player

Advanced Member

Have you
Family  Dats of Address Postal Parent/Guardian Parent/Guardian Parent/Guardian
FirstName  nName Birth ~ Gender Ethnicity 1 Suburb ‘code 1 Firstname 1 Surname 1 Mobile eyt
elsewhere?
ake Fakerson 02/02/2008 Female 132 Fake
" 12345 Not
ot Real 02/05/1986 Female =
[rest Tester  02/05/2001 Male 13 Fake
[rest Testertest 02/04/2001 Male test
aker Fakerson 20/12/1996 Female j2345 Net
Real 5t
fest test 12/04/2004 Female test
[rest Tester  01/01/2005 Female A
e Blogs _ 02/02/1973 Male test

rows
(Examined 10
ows)

Report Run Tue Feb 24 09:06:46 2015

Exporting reports to an email

For ease of use of the SA Sports Vouchers program, you can use CSV export through our email option. To
do this, scroll to the ‘Report Output’ heading, click the circle next to the Email option and ensure CSV is
highlighted in the drop down box. Add your email address in the box that is provided and click Run
Report. The report will open in another window (as shown above) and will also be sent to you.
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Report Output

Choose how you want to receive the data from this report.

Display
Open the report for viewing on the screen.

® Email
Email the report in a format suitable to be imported into another product.

| csv v | Email Address

= fun e

Saved Reports

The email heading will be ‘Data Export’ and will look similar to the below email.

Data Export Inbox  x &
admin@sportingpulse.com via amazonses.com @ 11:24 (0 minutes ago) L) v
to me |~
The data you requested for export is included in the attached file
<admin@sportingpulse.com>
B reportdata.csv '
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